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ORGANIZING YOUR PHOTOS
INTO LIGHTROOM COLLECTIONS

Lesson overview

This lesson covers how to sort through your images to separate the
ones that are keepers (that you will print, share, or put in your port-
folio) and ones you can discard or review later. You'll start by going
through a specific workflow for culling images using flags insAdobe
Photoshop Lightroom Classic, and walk through the processf sort-
ing those images into discrete collections. From there/yowllLlearn
how to set up a hierarchical structure using collection setss

In this lesson, you'll learn how to:

e Employ color labels in your image.

* Use a star system to rank your images.

 Filter images based on flags, ¢olors, or other metadata.
e Set up smart collections forspecialized tasks.

e Setup a target collection for, quick organization.

e Share and get feedback about your published online collections.

This lesson will take about 1% hours to complete. To get the lesson files
used insthis chapter, download them from the web page for this book at
adobepress.com/PhotoshopLightroomCIB2022. For more information, see
“Accessing the lesson files and Web Edition” in the Getting Started section
at the beginning of this book.


http://adobepress.com/PhotoshopLightroomCIB2022

The Lightroom Library module makes it easy to assess and
manage your ever-growing image catalog.




Preparing for this lesson

Before diving into the content of this lesson, make sure you do the following:

1 Follow the instructions in the Getting Started section at the beginning of this
book for setting up an LPCIB folder on your computer, downloading the lesson
files to that folder, and creating an LPCIB catalog in Lightroom.

2 Download the Lesson 02 folder from your Account page at adobepress.com to
username/Documents/LPCIB/Lessons.

3 Launch Lightroom, and open the LPCIB catalog you created by choosing File >
Open Catalog and navigating to it. Alternatively, you can choose File > Open
Recent > LPCIB Catalog.

4 Add the Lesson 2 files to the LPCIB catalog using the steps in the Lesson 1 section
“Importing photos from a hard drive” Lightroom may ask if you want to enable
address lookup. You can dismiss this notification.

Iterative culling: My workflow

The single most tedious task after a photo shoot is sorting bad pictures from good
so that you can come up with a plan for editing. This process is known as culling
and is one of the most important'steps you can do in Lightroom.

I spend a lot of time talking to people‘around the world about their use of Lightroom,
and this seems to be the part of the process people struggle with the most. To fix that,
I want to share the technique J'use when working with my photos. This is something
I learned a long time ago, back'in my days as a high school teacher, and I call it the
“iterative edit””

If you have to take a timed test of multiple choice questions, the best strategy for
completing'itis to go through the test as fast as you can, answering all the questions
that you know you have correct. When you get to a question that you do not know
the answer to, the strategy is to skip it. By doing this, you can quickly complete the
answers you do know, leaving you more time to work on the ones you don’t and
allowing you to pick up context clues from your completed answers.

Now, let’s apply this idea to our photography. If a shoot contains 200 pictures, there
is a good chance that a large number of those pictures are either really good or really
bad. By “bad” I mean things like: out of focus, the eyes are closed in a portrait, or you
cut off someone’s head. These are things that we immediately know are problems, and
we would never spend any time working on these images. Conversely, with the good
pictures, we're not trying to pick the very best picture out of the very best series.
We're looking for pictures that are okay: it’s exposed, it’s composed, it has the subject.
Ranking them is something we’ll do later.
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Adding flag markers in Lightroom

Let’s begin by going into the Lesson 01 folder in the Library module’s Folders panel
in Lightroom. This shows a grid of images that we can start culling. As we learned
in the previous lesson, we can get rid of the panels on all four sides by pressing Shift+
Tab. We can also black out the interface by pressing the L key twice to go into Lights
Out mode. This will get rid of all of the distractions in the Lightroom interface that

take us away from doing the job at hand—culling.

You have a couple of options with each image. If it is a picture that you think is
worth keeping, press P on the keyboard to mark it as a pick. If you believe the pic-
ture is completely off, press X to:mark it as rejected.

If you have to think forsmore than half a second about whether this picture is effec-
tive, press the Right Arrow key on the keyboard to skip the picture and go on to the
next one. Remember your qualifications for bad and good. Do not spend more than
a second thinking through these pictures. The goal is to get rid of the pictures that
you know will not work.

If you click one of the flags and the picture doesn’t advance, choose Photo > Auto
Advance. Should you mistakenly add the wrong flag to one of the pictures, press
the Left Arrow key to go back to the picture in question, and then press the U key.
Pressing U unflags the picture.

Once you finish this process, you should have your pictures sorted into three
different types of images: those that you know won’t work (the bad images), those
that you want to consider for ranking, and those that you have not gone through
yet. Lightroom has a way to filter all of these pictures: the Library Filter bar at the
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top of the center preview area. The Library Filter bar has the following options to
help you find specific images:

e Text mode allows you to filter your Lightroom catalog for specific words. These
words can be in the filename, title, caption, or any of the metadata embedded in
the image.

e Attribute mode lets you filter out images based on flag status, star rating, color
label, or virtual copy status, as shown below.

Atiribute

e Metadata mode lets you sort your images using a host of different metadata
items Lightroom has compiled from your images. This.is an extremely powerful
way of filtering, but outside the scope of this book.

Click the Attribute tab, then select one of the Flag options (pick, unflagged, or
rejected) to see only those specific images appearin thepreview area. The filter icons
are not exclusive—you don’t have to select only'Reject flags or Pick flags. If you click
both in the Attribute filter, Lightroom shows you both sets of images in Grid view.

At the top right of the Filmstrip panel, there are similar Filter options (if you don’t

see the flag icons next to the Filter menu, choose Flagged from the menu). At the
top left of the Filmstrip panel, you see the number of images in that folder or collec-
tion that contain a specific flag.
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At this point, the images that are the most important part of the process are the
unflagged ones. Click the Unflagged Photos Only icon, hide the panels (press Shift+
Tab), go into Lights Out mode (press L twice), and repeat the culling process until
nothing appears in the preview area.

You will notice that this second iteration of culling goes much faster than the first

one. The best thing about this part of the process is that you now have seen the
shoot in its entirety, and can make better judgments as to which pictures stay and
which pictures go. The only part you'll find disconcerting is the end—when you get
to a completely black screen. Don’t worry; just turn the lights back on’(press:L) and
bring back the panels (Shift+Tab). You'll notice the screen was black because there
were no more unflagged images. Click the Unflagged Photos Only icon again to
bring back all your photos, and your cull is complete!

What is a collection?

As your Lightroom library gets bigger and bigger, you'll need to have key images

in your catalog accessible for various purposes.:As mentioned, prior to Lightroom,
photographers who wanted to share.a group. of images, like a portfolio of portraits,
often placed copies of those pictures in‘a folder to share. As different needs arose,
they had to create other foldersiand store more copies of the same pictures in them.
Each folder had a specific neediand'contained copies of pictures that also lived in
other folders. Keeping track of the copies, and the space they occupy, makes this
solution untenable. This is where collections save the day.

If you're familiar with buying digital music, you can think of Lightroom collections

as playlists for your pictures. You purchase one song and own one physical copy of a
song, but that song can live in an unlimited number of playlists. The same holds true
for pictures and collections in Lightroom.

On the left side of the Library
module, you have a Collections
panel. Click the plus sign (+)
in the panel header, choose
Create Collection, and give

Create Smart Cdluk\..
Create Collection Set...

the collection a name. From
Sort by Hame

there, you can add images from v Sort by Kind

 Show Collection Filter

throughout your catalog to the

Note: Some
Lightroom users
prefer to maintain
multiple catalogs to
separate personal and
professional images. If
you're an experienced
Lightroom jockey, that
may work well for you.
However, because
the Lightroom search
features work on one
catalog at a time, you
may find it easier to
maintain a single
catalog.
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collection, no matter what folder they live in, and you can add as many collections
as you need for organization.

Every collection that you create in Lightroom can hold images from any folder you
have imported into your catalog. It doesn’t matter if the images live on your hard
drive, an external drive, or a network-attached storage drive. The Lightroom catalog
(your digital notebook) notes that you have one physical file but would like to have
a reference to that file in multiple collections. The collections serve as a way to look
at disparate parts of your photographic life without having to change your folders or
make copies of your photos to live in different folders. This is an extremely powerful
feature and one that your photographic life will revolve around.

In an effort to show you this concept in its simplest form, I'll share with you a series
of photos of my daughter, Sabine, and my wife, Jennifer.

Creating collections from folders of images

Let’s experiment with creating collections and adding images to them with the files
that we've imported for Lesson 2.

1 Go to the Folders panel in the Library module.andrclick the little triangle to the
left of the Lesson 02 folder. Inside that.folder, you'll see a series of folders that
we’ll make into collections.

2 Right-click one of the folders that contains the word Sabine in the name, and
select Create Collection“foldermame” from the menu.

3 Repeat this with all of the other folders that have the word Sabine in their names,
making collections for each of them. When you’re done, you should have a total
of six collections.

4 Press Command+D/Ctrl+D to deselect
all photos. Click the plus sign (+) on the
right side of the Collections panel’s header,
and create two additional collections: Best
Holiday Moments and Cute Sabine Pictures,
as you see here on the right.
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5 While it might seem repetitive to have collections that are named exactly like
your folders, there are a couple of really powerful things happening under the
hood here. First, unlike in a folder, you can drag the images around within the
preview area and sort them into whatever order you like.

Second, you have the option to add images from any of those Sabine collections
to the Best Holiday Moments or Cute Sabine Pictures collections. It doesn’t
matter where those images live or what folders they are in, you can simply drag
any of them into a new collection if you'd like. The catalog (your digital notebook)
will still reference that one physical file.

To show you the third important part about collections, click the thumbnail of
the first picture in the 20211031-sabine-pumpkin and drag it into both the Best
Holiday Moments and Cute Sabine Pictures collections.

6 Although we haven’t covered developing a picture yet, let’s make a quick change
to this photo. On theright side of the Library module, open the Quick Develop
panel’s Tone Control section. Under Exposure, click the double left arrow three
times. This should darken the image by three stops. You will see the change in
the image in this collection immediately.

R

Decrease Exposure: 1 Stop

ADOBE PHOTOSHOP AND LIGHTROOM CLASSIC FOR PHOTOGRAPHERS CLASSROOM IN A BOOK



The awesome part about

this is that the thumbnails

of this image in the other

two collections also will
change to reflect the darker
picture. You don't have to
remember where the physical

picture lives; Lightroom
automatically makes that
change across all instances of the image by referencing that one physical file.

Before we go any further, let’s create collections for the rest of the folders in the
Lesson 02 folder (all of the folders with the word Jenn in them). You should then
have a total of 17 collections.

Creating collection sets

It’s easy to see that our list of collections could get-a little:unwieldy. With so many
Sabine collections, it would be hard to scroll and visually:see where my work images
are versus my family images. That said, there is acommon element that runs through
all of these collections of Sabine: my daughter, Sabine.

1 Click the plus sign (+) on the right side of the Collections panel’s header, and
select Create Collection Set. In'the Create:Collection Set dialog box, create a set
called Sabine Images, and make sure the Inside A Collection Set check box in
the Location area is unselected. Once the collection set is created, drag all of the
Sabine collections into the Sabine Images collection set.

Create Collection...
Create Smart Collection...

Sort by Name
v Sort by Kind

The result is a much cleaner look Greate Collection Set
to the Collections panel. If you

MName: Sabine Images

want to see the pictures inside all s vm——

the Sabine collections, just click

the Sabine Images collection set. concel (ST
If you want to see pictures from ‘

one of the individual collections,

click that individual collection.
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2 We can take this a step further. The Jenn collections also could benefit from that
type of grouping. Create a collection set called Jenn Images, and make sure the
Inside A Collection Set check box is unselected. Then, drag all the Jenn.collections
inside the Jenn Images collection set. This makes our collections even cleaner.

3 We can still take this leyel of organization further. Another great benefit of the
collection set is that it holds not only collections but other collection sets as
well. Looking at the'collections that you have here, are there any other common
elements that we cansgroup around? Jenn and Sabine are my family. We could
theoretically create a collection set called Family Images and place both the
Sabine Images and Jenn Images collection sets in it.
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Then, should we want to see all the family images, we could click the Family Images
collection set. If we want to see a series of Jenn images, we can click the Jenn Images
collection set. If we want to see Sabine images, we can click the Sabine Images col-
lection set. To see individual events, we can click the individual collections to drill
down further. In other words, a place for everything, and everything in its place.

Sample organizational sets

Now that we know that our collections can be used to see a subset of pictures across
our catalog and that collection sets can let us organize all of those views, let’s put it
into other workflows that make sense.

Let’s say I work doing people photography, and I get an assignment to make a series
of pictures of my friend Latanya Henry. In that shoot, I would have several groups

of pictures—picked images to go over, rejected images, images'that I want to edit
further, images to take into a slideshow, and so on. If I made a'collection for each
group, what would happen if I got hired again to make another series of pictures for
Latanya? Would I just create “Latanya Picked Images Number 2” and name the other
collections in the same manner? That would be too.messy.

Instead, what if we made a collection
set for Latanya Henry? Then, when
Iimport the first shoot with Latanya,
I would make a collection set for that
specific shoot. Inside it, [ would place
all the collections that are related.to
that shoot.

The next time I shoot with\Latanya,
I'would create a collection set for
that second shoot;and repeat the
process. Not only/does this allow you
to see only what you want to see, but
it also lets'you separate out individual

images for the other functions in Lightroom, such as books or slideshows. You can
have a collection for each function.

On the next page are a series of sample suggestions that you can use to organize your
photography work. If you are a wedding photographer, you can use collection sets
on a per couple basis, with a collection set for each couple’s wedding. Inside each
wedding, you can separate production work (shots from multiple cameras) and the
finished work, using collections to sort out the various pieces of the wedding.

If you are a commercial photographer who does multi-day shoots, you can make
a collection set for the entire job, organize the days into individual collection sets,
and filter out the best shots into a “best of” collection. If you are a landscape pho-
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tographer, the organization would be similar to that of a commercial shoot, but
instead of jobs, you can sort by locations.

These samples are provided as ideas to get you going; not as hard-and-fast rules for
your photography work. The point is that you should take-a'moment to plan how you
want to organize your Lightroom catalog using collections‘and collection sets. Once
you do, it’s up to you to stick to that format.It’sa little time-consuming at first, but it
pays great dividends later on as your catalog,gets larger.

What is a smart collection?

Smart collections are collections
that you build based on pre- 2

defined criteria. Click the-plus - Collection Set..
sign (+) on the right side of the o Sort by Name
Collections panel’s header, and ' s
choose Create Smart Collection

' Show Collection Filter

from the menu.

In the Create Smart Collection dialog box, you can pick from a ton of different cri-
teria to pull images into your smart collection. Below the Match menu, the left side
shows you the criterion chosen, the center section gives you comparison options,

and the right side gives you the restrictions for each criterion. Click the plus sign (+)
at the upper right of the rules field to add another criterion (you can have as many

as you want).

Once the smart collection has been created, you will see it in the Collections panel
with a number of images in it. The number of images in a collection increases or
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decreases as you flag images across your entire catalog. In this example, I created a
smart collection that will keep track of images that I mark as rejected. As I flag my
images, no matter where in the catalog the rejected ones live, Lightroom will keep a
running tally of them inside this smart collection.

L] Create Smart Collection
Name: Rejected Images

Location

Inside a Collection Set

Match  al B8 of the following rules: flagged
unflagged
Pick Flag % is E  rejacted % ) =

I recommend that you drill down into that column on the left during your smart
collection creation. You'll find a ton of parameters that you can immediately put to
use in sorting your photographic work.

What is the Quick Collection?

There may be times when you don'’t necessarily need to create a collection, but
would like to temporarily organize

a set of images into a group. Rather
than creating and deleting a regular
collection, moving images around,
or exporting images unnecessarily;
you can use the QuickCollection.
The Quick Collection doesinotlive in
the Collections panel and is available
to you by clicking Quick Collection
in the Catalog panel or pressing
Command+B/Ctrl+B.

Add images to the Quick Collection as you move about the Library module by
selecting an image and pressing the B key. Or, in Grid view, click the small Quick
Collection circle in the upper right of any thumbnail; it turns gray to show you that
the photo has been added to the Quick Collection.

What is a target collection?

A target collection takes all the ease of adding images to the Quick Collection,
and following the same process, assigns the images to one of the regular collections
you've created. To use this feature, right-click a collection you've already created
and choose Set As Target Collection (you'll see a plus sign [+] appear to the right
of your collection name). Now, every time you press the B key, the selected image
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will be added to the
target collection you
specified, and not to
the Quick Collection.
To turn the target col-
lection off, right-click
it in the Collections
panel and choose Set
Target Collection from
the menu again. Then,

the images will go
back to being added
to the Quick Collection.

Sharing your collections online

Another benefit of having your images in collections is that you can share the col-
lections online. Previously, if you needed to get feedback on a shoot from someone
else (a client, family members, friends), you would have to export images from the
collection and import them into a third-party website.

In Lightroom Classic (desktop), you can automatically.sync a collection with
Lightroom (mobile) once you turn syncing on. Click the cloud icon at the right of
the Module Picker and click Start Syncing: Then,select the Sync With Lightroom
option in the Create Collection dialog box. Ifyouforget to do this when creating
your collection or decide to sync it later, simply click the lightning bolt icon to the
left of the collection name. Lightroom,Classic will generate the files and automati-
cally create an album in Lightroom,.as well as a private website you can view by
logging in at lightroom.adobe.com. You can make the gallery public by clicking the
Make Public button in.the'upper=right corner of the preview area.

After you click Make Public, Lightroom Classic creates a URL that you can share

with others (to the left of the button you clicked to make the website public, once
you have made it public). In the online version of Lightroom (which has fewer
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features than Lightroom Classic), all flags, star ratings, color labels, and other meta-

data settings will appear with the images (as you can see in Grid view below).

After clicking a thumbnail,
you are taken to Loupe view,
where you can click the

Info icon to see the photo’s
metadata or the Activity icon
to leave a comment or réad
other viewers’ comments.
Those comments:are auto-
matically savedto the cloud

and thenrsynced back to your
computerforiyou to review
in the Comments panel (which appears below the Metadata panel in Lightroom
Classic once a collection is made public).

Adding star ratings and color labels

Rating your images is pretty simple. Pressing the numbers 1-5 will add one to five
stars to any images you have selected. To remove any of the star ratings, just select
the image and press the number 0.

In addition to pressing 1-5 for star ratings, pressing the numbers 6, 7, 8, and 9 on
your keyboard will add the red, yellow, green, and blue colors labels, respectively.
There is one color left—purple—that can only be accessed through the Photo > Set
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Color Label menu. To remove the color from an individual picture, just select the

photo and press the number for the associated color again, and the color is gone.

Now that you know how to add star ratings and colors te-your pictures, let’s talk
about how best to use them. Once your pick and rejected flags have been assigned,
you can use star ratings to rank your pictures in'a “good, better, best” scenario.

The star rating system also can be useful for marking images for specific tasks or cat-
egories. Your portfolio shots can havefivesstars, while images that go into a slideshow
can be your four-star shots. Or, in awedding shoot, images of the groom’s family can
have three stars, while images of the bride’s family can be your two-star shots.

I like to use colors forfiles that [ am going to work on in Photoshop, files that are
ready for printing, and final edits of files. Any red-labeled images in my catalog are
images that need some work in Photoshop. The green-labeled images are ready for
printing. Purple-labeled images are final copies of images that need no additional
editing. I use purple for final images, as it’s the only color that I cannot accidentally
select with a number key. The colors also make it very easy to spot images that need
to be worked on while in Grid view.

Adding keywords

Adding keywords is an extremely powerful way to keep track of photos by subject
matter in your Lightroom catalog. Think of them as search terms, like the ones you
use to find something on the web. Keywords don’t take up much space—they’re text
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added to the photo’s metadata—so you can apply as many keywords to each photo
as you want.

For the best results, make your keywords descriptive of the subject matter, such as
“diving,” “snorkel,” “underwater,” “freedive;” and so on. Avoid adding keywords that
you've included in the photo’s filename, because the Lightroom search capability

extends to filenames, too.

You'll develop your own list of keywords as you go, but to get you started, use the
following steps to add keywords to the exercise files:

1 In the Library module, go to the Collections panel, and make sure that you have
the 20180725-jenn-diving collection selected. We will add some keywords here.

2 In the Grid view, select a series of images from this collection (click the first
photo you want to select, then Shift-click the last image to select all the images
in between).

Tip: To create 3 Inthe Keyword List panel on the right, click the plus sign (¥) on the left side of
nested keywords, the panel’s header. In the dialog box that appears; enter.Botella in the Keyword
select an existing
keyword in the
Keyword List panel field (use a comma to separate the synonyms). Select the Add To Selected Photos

Name field, and then type Snorkeling, Underwater, and Whale in the Synonyms

and then click the option, leave the three export optionsselected, and then click Create.
plus sign (+) to add
another keyword.
To see nested
keywords, click

the triangle to the
left of a keyword

in the Keyword List
panel to expand
your keyword
hierarchies. You
canalso type a
keyword into the
search field at the
top of the Keyword
List panel to reveal
itin the panel.

P
Create Keyword Tag

..Kcyword Mame: Botella

| Synonyms: | Snorkeling, Underwater, Whaleﬁ

Keyword Tag Options

Include on Export

Export Containing Keywords
Export Synonyms

Person

Creation Options

Add to selected photos

Your new “Botella” keyword appears in the Keyword List panel, and Lightroom
adds it to the selected photos. A general keyword like this also can serve as a
category in which to nest more specific keywords (say, “freedive” and “scuba”).

4 Now, select the last four images and repeat step 3, creating the keyword
Snorkeling and applying it to your selected photos.

5 To see all the photos in your Lightroom catalog that have a specific keyword,
move your pointer over the number to the right of that keyword in the Keyword
List panel and click the arrow that appears to the number’s right.
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When you click the
arrow to the right of
a keyword (circled),
Lightroom auto-
matically switches
your source to All
Photographs in the
Catalog panel. Once

appears in its lower-
right corner.

Other ways to apply (and delete) keywords

As you may imagine, there are additional ways to apply keywords. For example,
you can:

* Drag and drop the keyword from the Keyword List panel onto one.or multiple
selected thumbnail previews.

e Drag and drop one or more selected thumbnails onto akeywordin the Keyword
List panel.

e Select one or more thumbnails, and in the Keyword List panel, select the check
box that appears to the left of a keyword. To.remove a keyword from a photo, do
the same thing but deselect the checkbox that appears to its left.

e Use the Keywording panel (it’s above'the Keyword List panel). If you go this
route, you can create and apply keywords in the same step. To do this, select
some thumbnails and then click within the box labeled “Click here to add
keywords.” Enter a new keyword:If you want to create and apply more than
one keyword to the selected,photos, use a comma between each keyword. For
example, you may enter Dune, Desert and then press Enter/Return on your
keyboard to createand apply both keywords.

To delete a keyword from your list, use the Keyword List panel (not the Keywording
panel). Click the keyword and then click the minus sign (—) on the left side of the
panel’s header. In the warning dialog box that appears, click Delete.

Alternatively, right-click the keyword, and from the menu that appears, choose
Delete. In the warning dialog box, click Delete. In fact, the aforementioned menu
offers several useful options for managing your keywords. For example, you can edit
them, remove a keyword from the selected photo, or delete the keyword altogether.

Either way, the keyword is removed from your keyword list and from any photos
you applied it to.
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